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EKTRON, INC. SOFTWARE LICENSE AGREEMENT

** READ THIS BEFORE LOADING SOFTWARE**

YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS LICENSE 
AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT AGREE TO THIS SOFTWARE 
LICENSE AGREEMENT, DO NOT DOWNLOAD.

CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein (the 
“Software”). Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive indicates 
CUSTOMER’S acceptance of these terms and conditions. If CUSTOMER does not agree with the terms of this agreement, CUSTOMER 
should not download. 

Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on the 
following terms and conditions: 

        1.   Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only on 
a single URL. Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software beyond the 
number of authorized seats contained in the Basic Package without paying additional license fees as provided herein shall cause this 
license to terminate. Should CUSTOMER wish to add seats beyond the seats licensed in the Basic Package, the CUSTOMER may add 
seats on a block basis at the then current price for additional seats (see product pages for current price). The Basic Packages are as 
follows: 

Ektron CMS300 - Licensed for ten seats (10 named users) per URL. 

Ektron CMS400.NET - Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro - Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro+XML - Licensed for ten seats (10 named users) per URL.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.

The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is licensed, not 
sold.

        2.   Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should 
CUSTOMER breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License upon 
notification and demand by Ektron.

        3.   Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated 
into the Software) as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is 
protected by United States copyright laws and international treaties, and contains confidential information and trade secrets. 
CUSTOMER agrees to protect the confidentiality of the Software and Documentation. CUSTOMER agrees that it will not provide a copy 
of this Software or Documentation nor divulge any proprietary information of Ektron to any person, other than its employees, without 
the prior consent of Ektron; CUSTOMER shall use its best efforts to see that any user of the Software licensed hereunder complies with 
this license.

        4.   Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in 
material and workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. Ektron 
does not warrant the use of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited 
warranty shall not apply to any error or failure resulting from (i) machine error, (ii) Customer's failure to follow operating instructions, 
(iii) negligence or accident, or (iv) modifications to the Software by any person or entity other than Company. In the event of a breach of 
warranty, Customer’s sole and exclusive remedy, is repair of all or any portion of the Software. If such remedy fails of its essential 
purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a refund of the paid purchase price for the defective Products 
only. This limited warranty is only valid if Ektron receives written notice of breach of warranty within thirty days after the warranty period 
expires.

        5.   Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY 
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL WARRANTIES EXPRESS AND 
IMPLIED ARE HEREBY DISCLAIMED.

NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS 
OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER, 
CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, 
EVEN IF COMPANY OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.



         6.   Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way 
transferred without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the relationship 
between the parties contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of New 
Hampshire without regard to conflict of laws principles thereof. The parties agree that any action brought in connection with this 
Agreement shall be maintained only in a court of competent subject matter jurisdiction located in the State of New Hampshire or in any 
court to which appeal therefrom may be taken. The parties hereby consent to the exclusive personal jurisdiction of such courts in the 
State of New Hampshire for all such purposes. The United Nations Convention on Contracts for the International Sale of Goods is 
specifically excluded from governing this License. If any provision of this License is to be held unenforceable, such holding will not 
affect the validity of the other provisions hereof. Failure of a party to enforce any provision of this Agreement shall not constitute or be 
construed as a waiver of such provision or of the right to enforce such provision. If you fail to comply with any term of this License, 
YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License represents the entire understanding between the parties with respect 
to its subject matter.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND 
THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR 
COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS AGREEMENT’S TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS 
AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES. 

Copyright 1999 - 2006 Ektron, Inc. All rights reserved.

LA10031, Revision 1.7

Trademarks

All terms in this manual that are known to be trademarks have been capitalized. Ektron, Inc. cannot attest to the accuracy of this information. Use 
of a term in this manual does not affect the validity of any trademark.

The following trademarks might appear in Ektron manuals:

Active Directory®, ActiveX®, Authenticode®, BackOffice®, ClearType®, Developer Studio®, FrontPage®, IntelliSense®, JScript®, Microsoft ®, 
MS-DOS®, SharePoint ® Visual C++®, Visual C#®, Visual InterDev®, Visual J++®, Visual J#®, Visual Studio®, Visual Web Developer TM, 
Win32®, Win32s®, Windows®, Windows NT®, Windows Server TM, Windows Server System TM, Netscape®, Netscape Navigator®, Mozilla TM, 
Firefox TM



Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 i

Table of Contents

System Requirements.........................................................1
Server Requirements...................................................................1
PC Client Requirements ..............................................................2
Apple Macintosh Client Requirements ......................................2

Site Replication and Quick Deploy ....................................4
Comparison of Site Replication and Quick Deploy ..................5

Site Replication ...................................................................6
Site Replication vs. the Move Site Procedure ...........................7
Site Replication Overview...........................................................8

What Information is Synchronized..................................................... 8
What Information is Preserved .......................................................... 9
Preserving Custom Settings on Production Server while during Site 
Replication....................................................................................... 10

Possible Site Replication Configurations................................10
Site Replication Best Practices ................................................ 11
Prerequisites .............................................................................. 11
Installing the Site Replication Feature.....................................13

Additional Steps Prior to Configuring the Site Replication Feature . 25
Updating Membership Users ........................................................... 30
Preserving Database Tables............................................................ 31

Configuring the Site Replication Feature ................................32
Configuring the Receiving Server.................................................... 34

Configuration Screen ................................................................ 35
Security ..................................................................................... 36
Remote DB ............................................................................... 37
Backups .................................................................................... 37

Configuring the Sending Server ...................................................... 38
Configuration Screen ................................................................ 39
Destinations Screen.................................................................. 41
Remote DB Screen ................................................................... 42
Notification Screen.................................................................... 42
Make Staging Screen ................................................................ 43

The Site Replication Status Page .................................................... 44
Setting up a Staging Server ......................................................45
Previewing the Site Replication Process.................................46
Performing Site Replication......................................................47
Viewing and Restoring a Backup of the Production Server ..49

How Backup Files Are Maintained and Numbered.......................... 50
Setting the Maximum Number of Backups................................ 50

Restoring a Backup ......................................................................... 51



Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 ii

The Site Replication Configuration File...................................51
Hidden Elements ............................................................................. 52
Receive Section............................................................................... 52
Send Section ................................................................................... 54
Backup Section................................................................................ 56
Schedule Section............................................................................. 57
Site Replication web.config File....................................................... 57

Using Site Replication with Multiple Sites...............................58
Installation Guidelines ..................................................................... 58

Using Site Replication with Development > Staging > Produc-
tion Servers ................................................................................62

Moving .aspx Templates from Development to Staging Server ....... 63
Moving the Database from Development to Staging Server............ 64

Testing Site Replication Software ............................................64
List of Tests Per Server ................................................................... 67

The Scheduler Windows Service..............................................69
Running the Scheduler Service from a Remote Server................... 69
Troubleshooting the Scheduler Windows Service ........................... 70
Using the Scheduler Windows Service with Multiple Sites.............. 71
Uninstalling the Scheduler Windows Service .................................. 71

Troubleshooting Problems with Site Replication ...................71
Uninstalling Site Replication ....................................................76

Quick Deploy .....................................................................78
When Not to Use Quick Deploy ................................................78
Information Copied During Quick Deploy ...............................79

From Staging to Production Server ................................................. 79
From Production to Staging Server ................................................. 80

Quick Deploy Prerequisites ......................................................80
Enabling Multiple Production Destinations ...................................... 83

Using Quick Deploy...................................................................83
Automatic Movement of CMS Content Using Quick Deploy............ 83
Manual Movement of CMS Content Using Quick Deploy................ 84
Manual Movement of Menus and Collections Using Quick Deploy . 84

Linking to Library or Content Items ........................................... 86
Moving non-Content Files with Quick Deploy.................................. 88

Quick Deploy Troubleshooting.................................................90



 System Requirements

Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 Revision 6 1

System Requirements

The following components are required when developing or 
viewing Site Replication and Quick Deploy.

• ”Server Requirements” on page 1

• ”PC Client Requirements” on page 2

• ”Apple Macintosh Client Requirements” on page 2

Server Requirements

Component Requirements

Recommended hardware 
configuration

• Intel® Pentium® 4 supporting Hyper-Threading or 
Intel® Xeon® processor (with 800MHz bus)

• 1 GB RAM or higher

• RAID array for hard drives

Web server operating system Microsoft ® Windows® 2003 Server recommended
(32 bit version only)
Microsoft ® Windows® 2000, XP Professional 

Note: XP Home does not support IIS.

Web application server • Microsoft .NET ™ Framework 2.0 (required)

• Microsoft Active Server Pages

Web server Microsoft® Internet Information Server (IIS) 4.0 or 
higher
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PC Client Requirements

Apple Macintosh Client Requirements

Databases • SQL™ Server 2005

• SQL™ Server 2005 Express

• SQL™ Server 2000 (Enterprise or Standard ver-
sion)

Component Requirements

Component Requirements

Operating system Any IBM-PC compatible system running Windows (32 bit versions 
only)
Suggested minimum: Pentium 166 MHz or faster with 64MB of RAM

Browsers All major browsers including:

• Microsoft ® Internet Explorer 3.0 through 7.0

• Netscape Navigator ® Version 3.0 through 7.2 

• Mozilla Firefox

Hardware Any IBM-PC compatible system running Windows
(suggested minimum requirements: Pentium 166 MHz or faster with 
at least 64MB of RAM)

Component Requirements

Operating system MAC OS X
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Browsers All major browsers including:

• Apple Safari (Recommended)

• Microsoft ® Internet Explorer

• Netscape Navigator ® 

• Mozilla Firefox

Hardware Apple Macintosh

Component Requirements
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Site Replication and Quick 
Deploy

NOTE Ektron CMS400.NET’s Site Replication and Quick Deploy software is an extra 
cost option. Please contact your Ektron sales representative for details on 
purchasing it.

Site Replication and Quick Deploy are Ektron CMS400.NET 
features that move files between your staging and production 
servers. Site Replication moves an entire site, while Quick Deploy 
typically moves content to production as soon as it is published on 
staging.

See Also: 

• ”Comparison of Site Replication and Quick Deploy” on page 5

• ”Site Replication” on page 6

• ”Quick Deploy” on page 78

• Ektron’s Site Replication/Quick Deploy Best Practices Guide 
(http://dev.ektron.com/uploadedFiles/Resources/
EktronCMS400Replication-111706.pdf)

http://dev.ektron.com/uploadedFiles/Resources/EktronCMS400Replication-111706.pdf
http://dev.ektron.com/uploadedFiles/Resources/EktronCMS400Replication-111706.pdf
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Comparison of Site Replication and Quick Deploy
Feature Site Replication Quick Deploy

Direction of Movement From staging to production 
only

Two-way between staging and production

What is moved • Virtually everything 
entered in the staging 
server; see ”What 
Information is Syn-
chronized” on page 8

• Option to send data-
base and files or files 
only

• From staging to production: New/
updated content and files in folders set 
up for Quick Deploy; menus, collections, 
forum configuration information, users/ 
user groups; also, manually-selected files 
(e.g., templates) in Web root folder

• From production to staging: informa-
tion collected on production server, such 
as content analytics, poll/survey results, 
membership users, content and assets 
inside folders set up for Quick Deploy

What is not moved Content typically entered 
on production server; see 
”What Information is 
Preserved” on page 9

Files not listed above, under “What is 
moved”

How triggered Go to screen and click 
button

• Automatically when one of these events 
occurs on staging server.

- content in any folder for which Quick 
Deploy has been activated is 
updated (not necessarily published)

- a Quick Deploy folder is created or its 
properties, permissions, or approval 
chain is updated

- a CMS or membership user or user 
group is updated

• Manually by going to screen and clicking 
button

Backup of earlier version 
available; can be rolled 
back if needed

yes no

Can preview files to be 
moved beforehand

yes no
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Site Replication

WARNING! If you upgrade a staging server from version 5.2 to 7.0 but don’t choose to 
upgrade the production server, you need to complete some steps to make the two 
systems compatible.This procedure is explained in “Upgrading Ektron 
CMS400.NET” > “Updating a Site Replication Production Machine after 
Upgrading from 5.2 to 7.0” in the Ektron CMS400.NET Setup Manual.

Site Replication is an automated, one-way site synchronization 
between a staging or test server and a production server. It lets 
you perfect changes on a staging server, then effortlessly copy 
them to the production server. In this way, your production server 
can easily be kept up-to-date, while at the same time be spared 
simple errors that typically accompany last-minute changes.

(Synchronization differs from copying in that it only copies files that 
are new or have changed. Since most files on both servers are 
typically the same, synchronization is faster than copying.)

Whether you’ve been testing a new site template or an upgraded 
version of CMS400.NET, Site Replication pushes the latest 
information to the production server. Site Replication is especially 
useful when your site contains sensitive information (for example, 
pricing) that needs to be carefully reviewed for quality assurance 
before it goes live.

Can review files moved 
afterwards

yes yes

Schedule to run 
automatically at regular 
interval

yes no

Effect on database Creates new one Synchronizes parts of the database

Privileges needed Many privileges needed 
because it affects files and 
databases

Uses asp.net account

Feature Site Replication Quick Deploy
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Before the latest data is copied to the production server, it is 
backed up. So, you can restore the production server to an earlier 
version if you ever need to.

For more information about Site Replication, see these topics.

• ”Site Replication vs. the Move Site Procedure” on page 7

• ”Site Replication Overview” on page 8

• ”Possible Site Replication Configurations” on page 10

• ”Prerequisites” on page 11

• ”Installing the Site Replication Feature” on page 13

• ”Configuring the Site Replication Feature” on page 32

• ”Setting up a Staging Server” on page 45

• ”Previewing the Site Replication Process” on page 46

• ”Performing Site Replication” on page 47

• ”Viewing and Restoring a Backup of the Production Server” on 
page 49

• ”The Site Replication Configuration File” on page 51

• ”Using Site Replication with Multiple Sites” on page 58

• ”Using Site Replication with Development > Staging > 
Production Servers” on page 62

• ”Testing Site Replication Software” on page 64

• ”The Scheduler Windows Service” on page 69

• ”Troubleshooting Problems with Site Replication” on page 71

• ”Uninstalling Site Replication” on page 76

Site Replication vs. the Move Site Procedure
The Ektron CMS400.NET Setup Manual section “Installing Ektron 
CMS400.NET” > “Moving a Site to Another Directory or Server” 
describes a procedure for moving an eWebEditPro+XML Web site 
to a new folder or even a different server. You would use that 
procedure under the following circumstances:
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• The initial move of a site up to a shared server (or any other 
server on which you cannot run the .exe installer). 
Subsequently, you would use the Site Replication feature.

• Moving a site to a new server. For example, you purchase a 
new server to replace your existing one.

• Moving a site between two servers that are not connected by a 
network.

Site Replication Overview
First, install Site Replication software onto both servers. Next, 
supply configuration information for each server, such as the site 
directory and when replication begins.

Then, begin using Site Replication to synchronize the test server 
with the production server. Before initiating the synchronization, a 
Preview button displays the changes that will occur. Once you are 
ready, begin the synchronization.

At this point, the staging database is backed up then sent over. On 
the production server, that database is restored and given a new 
name. Production server files not on the staging server are deleted 
from the production server. During this time, a screen displays the 
real-time progress of the replication.

When synchronization is complete, you can view a log of changes 
made. If you decide the update should not have occurred, you can 
restore the receiving server.

You can apply security to Site Replication by restricting the IP 
address and user name of the machine/person who initiates the 
procedure.

NOTE You should verify that adequate space is available for the Site Replication. The 
data directories are backed up before the Site Replication begins. The previous 
version remains, creating a sitereplication.backup/.dirbackup date time file. A new 
copy of the data directories is placed in the same folder and is named dirupdates 
date time.

What Information is Synchronized
Synchronized information includes:
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• CMS400.NET code (the CMS400Scripts directory)

• CMS400.NET database schema changes

• CMS400.NET database content

• CMS400.NET assets

• Document Management Functionality code (the 
AssetManagement directory)

• templates (ASPX, ASP, PHP, JSP)

• library content (uploadedfiles and uploadedimages folders)

• CMS400.NET web.config file

• user list - However, when the user list is copied to the 
production server, non-administrative users’ permission to add 
content is removed.

What Information is Preserved
The following kinds of information are preserved on the production 
server, but not sent to the staging server.

• membership users (See Also: ”Updating Membership Users” 
on page 30)

• user profile settings

• license key and URL aliasing settings

• content ratings data

• content tracking statistics

• forum and blog posts (including forum private messages, 
attachments, and thread watches)

• community folders and permission changes

• CMS400.NET form data tables - contain form/poll/survey 
submissions from a Web site. Also, any tasks that track form 
data.

• Web.config settings (may need to be updated manually if you 
use Site Replication to push an Ektron CMS400.NET upgrade 
that includes new web.config settings. The new settings will not 
exist on the production server.)



 Site Replication

Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 10

• AssetManagement.config (only needs to be updated manually 
when upgrading if receiving server has Document 
Management Functionality)

• AssetManagementData.config (only needs to be updated 
manually when upgrading if receiving server has Document 
Management Functionality)

• The most recent searches table, use to generate the Search 
Phrase Report

• Optionally, a list of tables on the production machine (See Also: 
”Preserving Database Tables” on page 31)

NOTE SIte Replication does not install Windows services. To do that, you must upgrade 
Ektron CMS400.NET software on the production server.

Preserving Custom Settings on Production Server while 
during Site Replication

You can preserve custom web.config settings on the production 
server when doing site replication.

To do this, place the following code into the production server’s 
web.config file, within the <appSettings> tag. The key’s value is a 
comma-separated list of appsettings, like this.

    <add key="ek_ReplicationPreserveAppSettings" value="appsetting1,appsetting2" />

This code preserves the appsetting1 and appsetting2 keys in the 
production server’s web.config file during Site Replication.

Possible Site Replication Configurations
The following configurations are supported during Site Replication:

• CMS400.NET site and database on same server

- Assign unique names to the directories. For example, use 
http://localhost:81/StageRepl and http://localhost/ProdRepl 
for URLs.

- You can put Site Replication on different Web sites. (It is not 
part of Ektron CMS400.NET. It is a standalone Web 
application.)
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- The Production and Staging servers can use the same 
relative directory. For example, http://localhost:81/site 
root folder and http://localhost/site root folder.

• CMS400.NET site and database on separate servers

• Three servers: Development to Staging to Production 

- Configure the development server as a sending server. 
Send to the staging server.

- Configure staging server as sending server to production 
server. Then, add it as the receiving server for the 
development server. Its sending and receiving directories 
are the same.

- Configure the production server as the receiving server for 
the staging server

See Also: ”Using Site Replication with Development > Staging > 
Production Servers” on page 62

Site Replication Best Practices
• Each site must have its own database. Two sites cannot share 

a database.

• You cannot use Site Replication to move files from a production 
to a staging server.

• To sync the staging and production sites, run Quick Deploy 
once before running Site Replication for the first time.

• You cannot upgrade a staging server then use Site Replication 
to move those change to the production server. You must run 
the upgrade on each server.

• It is important to synchronize the clock on both servers (staging 
and production).

Prerequisites
Every user who will use Site Replication must be a member of the 
Administrators group within Windows’ Microsoft Management 
Console.
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To apply this setting to a user, follow these steps.

1. Click Start > Control Panel > Administrative Tools > 
Computer Management.

2. Click Local Users and Groups then the Users folder.

3. If the user does not appear in the right frame, right click the 
mouse and select New User.... Then complete the dialog.

4. Right mouse click on the user and select Properties.
5. Click the Member Of tab.



 Site Replication

Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 13

6. If you do not see Administrators in the Member Of window, 
click the Add button.

7. In the Enter the object names to select field, enter 
Administrators.

8. Click OK twice.

Installing the Site Replication Feature
You must install the Site Replication feature on the staging server 
and all production servers. After installing on a server, you should 
configure it. See Also: ”Configuring the Site Replication Feature” 
on page 32

1. Download the Site Replication.exe file from Ektron’s Web site.
2. Double click the downloaded file.
3. Follow the screen directions as they appear.
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Directions Screen

1. Indicate if this is a 
new installation or 
an upgrade.
If doing an 
upgrade, only 
perform steps 3 
and 6 below.
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2. Indicate whether 
the server on 
which you are 
installing will be 
used to send or 
receive 
information. A 
staging server 
would send, while 
a production 
server would 
receive.

Directions Screen
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3. Identify the Web 
site for which you 
are installing the 
Site Replication 
feature.
If you are unsure, 
accept the default.

4. Select the site 
host from the 
dropdown list. 
Or, you can check 
the Enter Host 
Manually box and 
enter the path to 
your site host.

Directions Screen
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5. Enter the directory 
in which Ektron 
CMS400.NET  
resides.

Important! The staging 
and production servers 
must use the same 
directory name (for 
example, http://
staging server/
MySite and http://
production server/
MySite). 
If not, the content may 
incorrectly reference 
images in the 
uploadedfiles 
directory of the staging 
server. As a result, the 
production server 
displays broken 
images.

Directions Screen
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6. Enter the folder to 
which the Site 
Replication files 
will be installed. If 
you are unsure, 
accept the default.

7. Click Yes or No to 
indicate if the 
server uses a 
remote database. 
That is, a 
database stored 
on a separate 
server.

Directions Screen
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8. If your receiving 
server uses a 
remote database 
server, the Site 
Replication 
feature uses a 
temporary folder 
to store the 
database prior to 
replication.
A default folder to 
be used for this 
purpose appears. 
You can accept 
the default or 
navigate to a 
different folder on 
the receiving 
server.

Directions Screen
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9. On the receiving 
server, enter the 
path to your 
installation of the 
MS SQL Server 
Data directory.

Directions Screen
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10. If you are 
configuring a 
receiving server, 
enter the path to 
your backups 
directory.
Before new 
information is 
pushed from the 
staging server, 
production server 
files are backed 
up to this 
directory. See 
Also:  ”Viewing 
and Restoring a 
Backup of the 
Production 
Server” on 
page 49

Directions Screen
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11. If you are 
configuring a 
sending server, 
you are prompted 
to enter a “from” 
email address. 
When site 
replication 
finishes, the 
notification uses 
this as the “from” 
email address.

Note: You can enter a 
“to” email address on 
the configuration 
screen.

Directions Screen



 Site Replication

Ektron CMS400.NET Site Repl icat ion Manual,  Version 2.0, Revision 8 23

Server Field
Enter the path to 
the server that 
hosts the 
database. If using 
a remote 
database, enter 
the path to the 
database server, 
not the receiving 
server.
Username and 
Password Fields
If using a trusted 
connection, leave 
the username and 
password blank.
Otherwise, enter a 
username and 
password specific 
to the database 
for the receiving 
and sending 
server.

Directions Screen
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12. Click the Install 
button to begin the 
installation.

13. The installation 
begins. When it is 
done, the screen 
on the right 
appears.

Directions Screen
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Additional Steps Prior to Configuring the Site Replication 
Feature

• If you are not using a trusted connection, the login user defined 
in the Ektron CMS400.NET web.config file needs sysadmin 
privileges. The login user is defined in the user tag within the 
web.config’s <connectionstring> element.
If you are using a trusted connection, the user running the 
replication needs sysadmin privileges.

• If you are using a remote database, configure the MSSQL 
Windows Service on the remote server to run as one of the 
following:

- a local user whose username/password combination on the 
Web server matches those settings on the SQL server 

- a Domain user. To set up a domain user, follow these steps.

1.Open SQL Server Management Studio.
2.Right click the database engine instance.
3.Select SQL Server Configuration Manager.

4.Under the Tree tab of the SQL Server Configuration 
Manager screen, select SQL Server 2005 Services.
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5.In the right panel, select SQL Server (MSSQLSERVER).
6.Right mouse click SQL Server (MSSQLSERVER).
7.Select Properties from the menu.
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8.On the SQL Server Properties screen, click the Log On 
tab.
9.Select This account.
10.Click the Browse button and find a domain user who 
exists on both the Ektron CMS400.NET and the database 
server.
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• Give the user selected above permission to read/write to the 
SiteReplication.Temp directory. To do so, follow these steps.

- Open Windows Explorer.

- Right mouse click the c:/sitereplication.temp folder.

- Select Properties.

- Click Sharing then Permissions.

- Assign to the user selected above permission to read and 
write to this directory.
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• If you will use email to communicate the completion of the 
replication, SMTP must be running on the sending (staging) 
server’s IIS. 
Also, the CDO objects must be installed. Mail will be sent from 
CMS400 Site Replication.
Finally, verify that your SMTP server allows relaying from the 
sending machine. You may need to set the Send\EmailFrom 
tag in the siterepl.config file to a valid internet email address. 
You can use the SendEmail web services API test in 
replication.asmx to test the configuration.

• Go to IIS > Default SMTP Virtual Server > Properties > 
Access tab > Relay button. Make sure the following field is 
checked: Allow all computers which successfully 
authenticate to relay, regardless of the list above.
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See Also: 

• ”Updating Membership Users” on page 30

• ”Preserving Database Tables” on page 31

Updating Membership Users
Typically, membership users are site visitors who register 
themselves via Web pages that reside on a production server. So, 
you would not want membership information on the staging server 
to overwrite that information.

However, if your staging server contains membership users that 
you want to move to the production server, follow these steps. You 
might do this on a one-time basis if, for example before your 
production server goes live.

1. On the production server, navigate to the folder CMS400 server/
Documents and settings/all users/application data.

2. Open the sitereplCMS400Replication.config file with a simple 
word processor, such as Notepad.
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3. Set the value of PreserveMembershipUsers to False.
<entry name="PreserveMembershipUsers">False</entry>

4. Save and close the file.
The next time you run Site Replication, all membership user 
information on the staging server will be sent to the production 
server.

After running the replication, you would typically change the value 
of PreserveMembershipUsers to True, so that subsequent replications 
do not affect membership users on the production server.

Preserving Database Tables
Some customers have a custom set of tables in the production 
database for tracking unique information. If your site has custom 
tables that you want to preserve during replication, follow these 
steps to instruct the site replication to do that.

1. On the production server, navigate to the folder CMS400 server/
Documents and settings/all users/application data.

2. Open the sitereplCMS400Replication.config file with a simple 
word processor, such as Notepad.

3. Within the PreserveTables entry, list the tables to be preserved 
during replication. 

<entry name="PreserveTables">my_custom_table_tbl</entry>

NOTE If you enter more than one table, separate each with a comma.

Since the tables may have foreign key relationships, list the 
primary key tables first. When the tables are deleted, they are 
deleted in reverse order, so there are no foreign key errors.
When the tables are copied, it is done in forward order so the 
primary keys are restored before the foreign keys reference 
them.

4. Save and close the file.
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Configuring the Site Replication Feature
To configure the Site Replication feature, enter the following into 
your Web browser’s address field:

http://localhost/cms400replication/ConfigReplication.aspx

Alternatively, follow this path from the Start menu.

Start > All Programs > Ektron > Site Replication > CMS400 Site 
Replication

The following screen appears if you chose to set up a receiving 
machine.

The following screen appears if you chose to set up a sending 
machine.
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This screen displays the following Site Replication information:

• current status

• the receiving directory

• the sending directory

• test configuration

This screen also links to other screens that let you configure, run, 
and get a detailed status of the replication process. Click 
Configure Send to configure your staging server, and Configure 
Receive to configure a production server.

NOTE Only configure the send page on the staging server, and the receive page on the 
production server.

See Also: 

• ”Configuring the Receiving Server” on page 34

• ”Configuring the Sending Server” on page 38

• ”The Site Replication Status Page” on page 44

• ”Testing Site Replication Software” on page 64
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Configuring the Receiving Server
Use the configuration receive page to set up information about a 
receiving server.

NOTE To return to the home screen, click Replication in the top left corner.

This screen has four secondary screens, listed across the top:

• ”Configuration Screen” on page 35

• ”Security” on page 36

• ”Remote DB” on page 37

• ”Backups” on page 37
The following table explains the initial screen’s fields.
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Configuration Screen

Field Description

Enable Receive Determines whether the server you are signed into can receive Site 
Replication information.

 Checked = Receive

 Not checked = Do not receive

Receive Directory The site directory on the receiving (production) server that is updated 
when Site Replication occurs. For example:
c:\inetpub\wwwroot\site root folder

Note: If you just installed the Site Replication feature, the receiving 
directory you specified during installation appears.

Multisite Directories If your configuration includes several Web sites, you must set up Site 
Replication for each Multisite Receive Directory.
In this field, insert in a comma-separated list of all other multisite 
directories. (No spaces are allowed in the list.)
The Site Replication feature uses this information to point each 
web.config file to the same database.

MSSQL Data Directory The location of the MSSQL database directory. The default is: 
c:\Program Files\Microsoft SQL Server\MSSQL\Data

MSSQL Log Directory Enter the location of the MSSQL Log directory, which stores your 
MSSQL .ldf files. 

Backups Directory The location of the Site Replication backup files. For example: 
c:\SiteReplication.Backups

The backup directory may require a large amount of space, 
depending on the size of your site and if you are using the Document 
Management Functionality. See Also: ”Viewing and Restoring a 
Backup of the Production Server” on page 49

Save Button 
Saves the receiving (production) server information.
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Security

Field Description

Valid Username Username used for authentication on receiving (production) server. If 
you are setting up a receiving server that uses a trusted connection, 
this user needs sysadmin access for MSSQL.
Also, this value must match the Username on the Configuration 
Sending Server screen.
Ektron recommends entering the name in this format: domain 
name\username.

Note: You do not need to complete this field. If you do, this 
information provides additional security for which user can send data 
to this server.

Valid Sender IP The IP address of the sending (staging) server, which will be 
synchronized with the production server you are configuring.
It must be a static IP address.

Note: You do not need to complete this field. If you do, this 
information provides additional security for which server can send 
data to this server.

Save Button 
Save the receiving (production) server information.
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Remote DB

Backups

Field Description

DB Server’s Temp Dir Most databases can only back up and restore to a local drive. So if 
your database server is on a different machine than your CMS, both 
machines must share a domain/group and a user/password for 
directory access.
Ektron recommends setting up a separate directory named 
SiteReplication.Temp and sharing it on the staging or production 
server (whichever uses the remote database server). The database 
server can connect to this network share via a UNC path.

Note: The MSSQL service must run as a domain user to be able to 
access a UNC share. 

Receive DB Temp Dir If the receiving server uses a remote database server, enter the UNC 
path to the shared directory on that server. See Also: ”DB Server’s 
Temp Dir” on page 37

Save Button 
Save the receiving (production) server information.

Field Description

Replication Backups Displays the number of Site Replication backups stored in the 
backups directory. See Also: ”Setting the Maximum Number of 
Backups” on page 50
The selection box directly below this label lists all saved backups. 
See Also:  ”Viewing and Restoring a Backup of the Production 
Server” on page 49 

 Button 
Choose a backup from the replication backups selection box.
Click Restore to replace the site on the receiving server with the 
selected backup. See Also: ”Viewing and Restoring a Backup of the 
Production Server” on page 49 
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Configuring the Sending Server
The first time you configure the sending (staging) server, follow the 
procedure described in ”Setting up a Staging Server” on page 45. 
Later, you can use the Configure Send page modify that 
information.

NOTE To return to the home screen, click Replication in the top left corner.

This screen has these secondary screens, listed across the top:

• ”Configuration Screen” on page 39

• ”Destinations Screen” on page 41

• ”Remote DB Screen” on page 42

• ”Notification Screen” on page 42
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• ”Setting up a Staging Server” on page 45

The following tables explain the screens.

Configuration Screen

Field Description

Send Directory The location of site directory on the sending server whose content 
will be synchronized with the production server. For example: 
c:\inetpub\wwwroot\site root folder

Exclude Files If you want to exclude certain file types from the replication, enter 
them here. For example, you may want to exclude all PDF files.
For each file type, enter an asterisk (), period(.), then the file 
extension. For example *.pdf.
Separate each extension with a comma.

Delete Removed Files During Site Replication, files that were deleted on the staging server 
are now labeled “deleted” on the production server. Check this box if 
you want to remove these files from the production server.

Send DB When Indicate if you want to copy the Ektron CMS400.NET  database to 
the named destination servers. Your choices are:

• Always

• 1st Destination only (only copy the database to the first desti-
nation server listed above)

• Never
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Schedule On To begin the replication as soon as you press the Send button, leave 
this field blank.
To schedule the replication for a future date and time, click the 
calendar button and choose a date.
To the right of the Schedule On field is a dropdown box that lets you 
schedule Site Replication to run on a regular basis, such as weekly.

If you want to run Site Replication automatically at one of these 
intervals, select it. See Also: ”The Scheduler Windows Service” on 
page 69

Destinations The path to the replication.asmx file on every production server that 
will be updated by this staging server. For example:
http://productionserver1/CMS400replication/
replication.asmx

or
http://198.0.25.214/CMS400replication/replication.asmx

You must enter the username and password needed to access that 
folder before pressing the Add button to add a destination folder.

Windows Username Username used for authentication on receiving (production) server. If 
you are setting up a receiving server that uses a trusted connection, 
this user needs sysadmin access for MSSQL. Enter the 
domainname\username.
It must match the WS Username on the production server’s 
Configuration Receiving Server screen.

Password Password for the above user.

Send Button 
Begin the Site Replication process. If you scheduled a date/time, the 
process is delayed until then.

Field Description
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Destinations Screen

Field Description

Destinations A Display-only field that lists the path to the replication.asmx file on 
every production server that will be updated by this staging server.

Destination to add Enter the path to the replication.asmx file on every production server 
that will be updated by this staging server. For example:
http://productionserver1/CMS400replication/
replication.asmx

or
http://198.0.25.214/CMS400replication/replication.asmx

You must enter the username and password needed to access that 
folder before pressing the Add button to add a destination folder.

Windows Username Username used for authentication on receiving (production) server. If 
you are setting up a receiving server that uses a trusted connection, 
this user needs sysadmin access for MSSQL. Enter the 
domainname\username.
It must match the WS Username on the production server’s 
Configuration Receiving Server screen.

Password Password for the above user.

Add Button 
Add a new Destination. See Also: ”Destinations” on page 40
Before pressing this button, make sure that a valid destination 
appears in the Destinations field, and the username and password 
needed to access that folder appear in their respective fields.

Preview Changes Button Preview a list of changes to take place when the Site Replication 
occurs. Use this feature to examine which changes are scheduled 
before replication begins.
Before pressing this button, make sure a valid destination appears in 
the Destinations field, and the username and password needed to 
access that folder appear in their respective fields.
Then, select a production server from the Destinations field.

See Also:  ”Previewing the Site Replication Process” on page 46
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Remote DB Screen

Notification Screen

Field Description

DB Server’s Temp Dir Most databases can only back up and restore to a local drive. So, if 
your database server is on a different machine than your CMS, both 
machines must share a domain/group and a user/password for 
directory access.
Ektron recommends setting up a separate directory named 
SiteReplication.Temp and sharing it on the site replication server. 
The database server can connect to this network share via a UNC 
path.
So, if the sending server uses a remote database server, enter the 
site replication server’s shared directory.

Send DB Temp Dir If the sending server uses a remote database server, enter the UNC 
path to the shared directory on that server.

Field Description

email Notification to Use this field to notify someone when the site replication is finished. 
Enter the email address of the person you want to notify.

Note: email notification only works if the sending server’s SMTP mail 
service is enabled. See Also: ”If you will use email to communicate 
the completion of the replication, SMTP must be running on the 
sending (staging) server’s IIS.” on page 29

Here is an example of the email resulting from a successful 
replication.
Completed At 10/7/2005 9:50:26 AM

From Address Enter the name that will appear in the email’s from line.
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Make Staging Screen

This screen helps you to set up a staging server when only a 
production server is currently available. The screen facilitates the 
setup of the staging server by

• copying Web site and database information from the 
production server to the staging server

• initializing the staging server with content from the production 
server

For more information, see ”Setting up a Staging Server” on 
page 45.

.

Field Description

New Connection String Enter a connection string pointing to the new database.

MSSQL Data Directory Enter the location of the staging server’s MSSQL database directory. 
The default is: 
c:\Program Files\Microsoft SQL Server\MSSQL\Data

MSSQL Log Directory Enter the location of the staging server’s MSSQL Log directory, 
which stores your MSSQL .ldf files.

Temp Directory

Windows Username Enter the Username used for authentication on receiving 
(production) server. If you are setting up a receiving server that uses 
a trusted connection, this user needs sysadmin access for MSSQL. 
Enter the domainname\username.
It must match the WS Username on the production server’s 
Configuration Receiving Server screen.

Password Enter the password for the above user.
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The Site Replication Status Page
The status page keeps you informed of the Site Replication 
process. Specifically, it lists the current status of the Site 
Replication. Also, If a replication is currently in progress, the page 
displays

• the percentage of completion

• the file currently being replicated

• the destination server’s URL

Click this button when you are ready to create the staging server 
based on the information entered on the screen. 
Before pressing this button, make sure you completed ”Setting up a 
Staging Server” on page 45.
When you click the Create Staging button, Site Replication copies 
the site root folder, the assetlibrary directory, and the CMS400 
database form the production server to the staging server.

Field Description
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Setting up a Staging Server
Follow these directions if you are migrating from a single-server 
model to a two-server model, that is, a staging and production 
server. Your current server becomes a production server, and the 
new server will be a staging server.

After purchasing the appropriate licensing and downloading the 
Site Replication software, follow these steps.

WARNING! Only follow these steps to set up a sending server. After that, you can perform Site 
Replication by following ”Performing Site Replication” on page 47.

1. Install Ektron CMS400.NET on the staging server. Set it up 
exactly like the production server (for example, all directories 
must have the same name).

NOTE This procedure is described in the Ektron CMS400.NET Setup Manual.

During installation, when you are asked to specify Setup Type, 
choose Minimal.

2. Install Site Replication software on both servers. See ”Installing 
the Site Replication Feature” on page 13.

3. Follow the steps described in ”Additional Steps Prior to 
Configuring the Site Replication Feature” on page 25.

4. Configure Site Replication software on the production server 
according to instructions in ”Configuring the Receiving Server” 
on page 34.

5. On the sending server, enter the following into the browser 
address bar: http://localhost/ConfigReplSend.aspx

6. Click the Destinations tab.
7. In the Destinations to Add field, enter the path to the 

replication.asmx file on the production server. For example:
http://productionserver1/CMS400replication/replication.asmx

or
http://198.0.25.214/CMS400replication/replication.asmx

Enter only one destination.
8. Enter the username and password needed to access that 

folder.
9. Press the Add button.
10. Click the Configuration tab. 
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11. In the Send Directory field, enter the send server’s site root 
directory.

12. Click the Make Staging tab. This screen facilitates the setup of 
the staging server by

• copying Web site and database information from the 
production server to the staging server

• initializing the staging server with content from the production 
server

13. In the New Connection String field, enter a connection string 
pointing to the new database. You can copy this from the 
web.config file. For example

server=(local);database=remotedb;Integrated Security=true;user=sams;pwd=sam123;

14. In the MSSQL Data Directory and MSSQL Log Directory 
fields, specify the location of the MSSQL data and log 
directories.

15. Enter the username and password needed to access the 
production server.

16. Click Create Staging.
17. The Site Replication software initializes the staging server with 

content from the production server.

Previewing the Site Replication Process
After you configure the Site Replication feature, you can preview 
which files the replication will transfer before beginning the 
replication.

If the list looks correct, proceed with the replication. If the list looks 
wrong or incomplete, review the contents of the sending (staging) 
server to make sure all content was updated properly. Then, run 
the preview again to make sure the list of files to be moved is 
correct before beginning the replication.

To use the preview feature, follow these steps.

1. To access the Site Replication feature, enter the following into 
your Web browser’s address field:

http://localhost/cms400replication/ConfigReplication.aspx
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2. Click Configure Send.
3. In the Destination field, select the production server with 

which you will synchronize.
4. Enter the password required to access that production server.
5. Click the Preview Changes button.
6. A list of files to be transferred to the production server appears.

Performing Site Replication
For background information about Site Replication, see ”Site 
Replication” on page 6.

You must configure the Site Replication feature before beginning 
the actual replication.

IMPORTANT! Make sure that the system clock on both servers is set to the same time. The Site 
Replication software uses the clock to determine which files to replicate.

Before beginning the site replication, check free space on the 
receiving (production) server to make sure it can accommodate 
your site directory on the sending (staging) server. Also, Ektron 
recommends using the Preview feature to identify which files will 
be moved by the replication prior to beginning. See Also: 
”Previewing the Site Replication Process” on page 46

To use the Site Replication, follow these steps.

1. To access the Site Replication feature, enter the following into 
your Web browser’s address field:

http://localhost/cms400replication/ConfigReplication.aspx

2. Click Configure Send.
3. In the Destination field, select the production server with 

which you will synchronize.
4. Enter the Username and password required to access that 

production server.
5. If you want to begin the replication in the future, use the 

Schedule on field. See Also: ”Schedule On” on page 40. 
Otherwise, proceed to the next step.

6. Click the Send button.
7. The replication begins.
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8. The main screen of the sending server changes to the 
following, indicating you cannot edit its configuration 
information while replication is taking place.

9. To view the progress of the replication, click Status. A screen 
like the following displays.

The screen displays the following information:

• Destination - the receiving server

• Overall - the number of files already transferred/the total 
number of files to be transferred

• Current File - the file currently being transferred
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• Status - Information about the replication (number of kilobytes 
sent so far, time elapsed, speed of transfer)

10. A list of files transferred to the production server appears.
After completing the replication, it’s a good idea to spot check the 
content on the production server to verify that the replication was 
successful. The following files are available on the receiving server 
to help you do this.

• log*.txt files store the logs (including errors)

• backup* directories store any changed or deleted files

• dirupdate* directories store pending updates

• dirbackup* directories store snapshots of entire CMS400 
directories (To disable this feature, set the 
Receive\FullDirBackup tag in siterepl*.config to false.)

Viewing and Restoring a Backup of the Production 
Server

When you run a Site Replication, a backup is made of the receiving 
(production) server before any new or updated files are copied 
from the sending (staging) server. Only files with the same name 
but a earlier edit date/time are backed up. A backup directory is 
specified during installation. After installation, the directory can be 
changed via the receiving server’s Configuration screen. See 
Also: ”Configuring the Receiving Server” on page 34

On that screen, you can see how many backups are available. 
Below that, a drop-down box displays information about each 
backup, such as creation date, time and user.
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You can also view a log of the selected backup, which lists every 
file copied from the sending to the receiving server. To see the log, 
click the Show Log button.

See Also: 

• ”How Backup Files Are Maintained and Numbered” on page 50

• ”Restoring a Backup” on page 51

How Backup Files Are Maintained and Numbered
The Site Replication feature keeps up to a user-defined number of 
the most recent backups. So, if 10 is the maximum and that many 
are saved when you initiate a new replication, the oldest backup is 
deleted. The current files about to be replaced are saved as the 
number one backup. All remaining backups are renumbered one 
higher.

Setting the Maximum Number of Backups

By default, the 10 most recent backups are kept. If you want to 
change this number, follow these steps.

1. In Windows Explorer, navigate to the folder to which you 
installed Site Replication. 

2. Open the web.config file.
3. Adjust the value of the ek_MaxBackups tag, as indicated below.
<add key="ek_MaxBackups" value="10"/>
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Restoring a Backup
When you restore a backup, only files that were overwritten and 
the web.config, assetmanagement.config, 
assetmanagementdata.config files are restored. Any new files 
copied to the production server are not deleted.

To restore a backup of files on the receiving (production) server, 
follow these steps.

1. To access the Site Replication feature, enter the following into 
your Web browser’s address field:

http://localhost/cms400replication/ConfigReplication.aspx

2. Click Configure Receive.
3. In the bottom section of the screen, display the drop-down 

selection box under Replication backups.
4. Select the backup that you want to restore.
5. Click Restore.

The Site Replication Configuration File
The Site Replication feature has a configuration file that maintains 
and lets you update values set during installation and 
configuration. Its name is sitereplCMS400Replication.config, and it 
is located in the C:\Documents and Settings\All Users\Application 
Data directory.

You can move the file to a different location. To do that, update the 
ek_ConfigFile tag in the corresponding Web site’s web.config file.

The following tables describes the file’s elements.

• ”Receive Section” on page 52

• ”Send Section” on page 54

• ”Backup Section” on page 56

• ”Schedule Section” on page 57

See Also: ”Site Replication web.config File” on page 57
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Hidden Elements
Elements that are prefixed with an asterisk (*) do not appear in the 
configuration file, but you can add them to change their value. 
They are hidden because they are typically not used.

Receive Section
These settings apply to the production server.

Element Default Value Description

Receive Enabled true = Site Replication is 
enabled
false = Site Replication is not 
enabled

Indicates whether Site Replication is enabled 
on the production server.

Receive Dir Your Ektron CMS400.NET  
Web site. The sample site is 
installed to 
c:\inetpub\wwwroot\site 
root folder

The directory that contains your Ektron 
CMS400.NET  Web site.

username Determines which users can send to the 
production server. You can also update this 
field via the Security tab.

Sender IP Determines which computers can send to the 
production server. You can also update this 
field via the Security tab.

*HookURL Allows you to “hook” a Web service into the 
replication process. The hook lets you send 
custom directories/databases during Site 
Replication.

*AllowAddContent CMS users' permissions for adding content 
on the receive machine are usually disabled. 
This setting lets CMS users add content on 
the receiving machine.
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BackupDir C:\SiteReplication.Backups The directory to which your Site Replication 
backups are written.
This value can also be updated from the 
Receiving Configuration screen’s 
Configuration tab’s Backups Directory 
field.

MSSQLDataDir C:\Program Files\Microsoft SQL 
Server\MSSQL\Data

The location of your remote MS SQL Data 
Directory from the viewpoint of the MSSQL 
server.
This value can also be updated from the 
Receiving Configuration screen’s 
Configuration tab’s MSSQL Data Directory 
field.

MSSQLLogDir C:\Program Files\Microsoft SQL 
Server\MSSQL\Log

The location of your remote MS SQL Log 
Directory from the viewpoint of the MSSQL 
server.

* MultiSiteDirs A list of other multisite directories. The Site 
Replication feature uses this information to 
determine the directories in which to update 
the web.config file.

DBTempDir See ”DB Server’s Temp Dir” on page 37
This value can also be updated from the 
Receiving Configuration screen’s Remote 
DB tab’s DB Server’s Temp Dir field.

MappedDBTempDir See ”Receive DB Temp Dir” on page 37
This value can also be updated from the 
Receiving Configuration screen’s Remote 
DB tab’s Receive DB Temp Dir field.

Element Default Value Description
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Send Section
These settings apply to the staging server.

PreserveTables An optional list of database tables (comma-
separated) that you want to preserve on the 
production server.
Since the tables may have foreign key 
relationships, they should be listed with the 
primary key tables first.
When tables are deleted, it occurs in reverse 
order so there are no foreign key errors. 
When the tables are copied, it occurs in 
forward order, so the primary keys are 
restored before the foreign keys reference 
them.

FullDirBackup true If set to true, your site is backed up when 
Site Replication is run. 

DeleteOldDBs true If set to true, replication only maintains the 
maximum number of databases. See Also: 
”Setting the Maximum Number of Backups” 
on page 50
Once the maximum number has been saved, 
the next time replication occurs, the oldest 
database is deleted from the Site Replication 
software. Your MSSQL administrator must 
manually delete the old database.
If set to false, all old databases are kept.

PreserveMembershipU
sers

true On the production server, Ektron 
CMS400.NET  and membership users can 
update information about themselves. For 
example, they can change their first or last 
name, password, display name, or language.
If this is set to true, changes submitted on 
the production machine update that 
information on the staging server. 

Element Default Value Description
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Element Default Value Description

URLCount 0 The destination URLs on the Send > Destinations 
tab.

URLCount name Dir The destination URLs on the Send > Destinations 
tab.

Username Username for accessing the sending server’s 
database.
If entered, this value overrides settings in the 
staging server’s web.config file.

*HookURL Allows you to “hook” a Web service into the 
replication process. The hook lets you send 
custom directories/databases during Site 
Replication.

SendStageTemp The temp directory as defined on the Make 
Staging tab. 

SendBufferSizeKB Sets the buffer size used to transfer data.

SchedRepeat Indicates when scheduled replications occur.

DeleteFiles Deletes files on Receive machine that are not on 
Send machine
If your version of Ektron CMS400.NET  is 7.0 or 
higher, you should only set this to true if you do 
not allow content/attachments/images to be added 
on the receive machine.

DBTempDir See ”DB Server’s Temp Dir” on page 42
This value can also be updated from the Sending 
Configuration screen’s Remote DB Screen 
Screen tab’s DB Server’s Temp Dir field.

MappedDBTempDir See ”Send DB Temp Dir” on page 42
This value can also be updated from the Sending 
Configuration screen’s Remote DB Screen 
Screen tab’s Receive DB Temp Dir field.
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Backup Section
These settings apply to the Site Replication backup procedure.

DBWhen See ”Send DB When” on page 39
This value can also be updated from the Sending 
Configuration screen’s Configuration Screen 
tab’s Send DB When field.

NotifyEmail See ”email Notification to” on page 42
This value can also be updated from the Sending 
Configuration screen’s Notification Screen tab’s 
email Notification to field.

FileExcludeMask See ”Exclude Files” on page 39
This value can also be updated from the Sending 
Configuration screen’s Configuration Screen 
tab’s Exclude Files field.

EmailFrom “CMS400 Site 
Replication”; only 
works if the customer’s 
SMTP server requires 
a valid “from” address

The “from” address of notification email.
You should change this to a valid “from” email 
address. The SMTP server and authentication 
information are taken from the staging server’s 
web.config file.
This value can also be updated from the Sending 
Configuration screen’s Notification Screen tab’s 
From Address field.

Element Default Value Description

Element Default Value Description

Count 0

*DirN The backup directory

*DateN The timestamp of when the backup was performed

*UserN The user who completed the replication

*PendingDir Can be ignored
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Schedule Section
These settings apply to Site Replication scheduling. See Also: ”The 
Scheduler Windows Service” on page 69

Site Replication web.config File
The Site Replication feature has a web.config file that is installed to 
the directory to which you installed Site Replication. You should 
only modify a few elements within the <appsettings> section. They 
are described below.

*PendingDate Can be ignored

*PendingUsername Can be ignored

Element Default Value Description

Element Description

*StartTime Starting time of the replication

*Username User name to use when performing a scheduled 
replication.

*Password Password to use when performing a scheduled 
replication

Element Description

ek_SQLCmdTimeout Timeout for SQL commands. Only increase this value if you have a 
large, very busy database.

ek_WSTimeout Timeout for Web service calls. Only increase this value if you have a 
slow network.
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Using Site Replication with Multiple Sites
If you are using Ektron CMS400.NET’s Site Replication feature to 
copy content from your staging to production server, you must 
replicate all files at one time. You cannot replicate only one site, 
since all sites share library files.

While configuring the Replication Send screen, use the Add button 
to identify all destination directories. See Also: ”Configuring the 
Site Replication Feature” on page 32

When setting up Site Replication for receiving site, in the 
Destination field, select the appropriate destination directory. See 
Also: ”Performing Site Replication” on page 47

See Also: ”Installation Guidelines” on page 58

Installation Guidelines
To set up multiple sites on a staging server, follow these guidelines.

1. Install the Site Replication feature separately for each site. On 
the following installation screen, be sure the site is unique.

 ek_SimpleUI Simplifies the Send screen by only displaying the username, 
password, and send buttons.
Set this tag to true if you want to disable most of the configurable 
information for “dumb” users.

ek_RestoreIndexingState Set to false if you want to prevent the Site Replication feature from 
starting the indexing service.

ek_MaxBackups Determines the maximum number of backups that Site Replication 
will keep. See Also: ”Setting the Maximum Number of Backups” on 
page 50

Element Description
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2. When asked to identify the site path directory, be sure the 
directory name is unique for each site.
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3. If your receiving server uses a remote database server, it is 
good practice for each site to use a unique temporary folder to 
store the database prior to replication.
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4. Specify a unique backup directory for each site.

Using Site Replication with Development > Staging 
> Production Servers

There are two scenarios in which you can use Site Replication 
across a development, staging, and production server 
configuration. 

• you create .aspx templates on a development server and move 
them to a staging server

• you’re making a radical change to the staging database. In this 
case, copy the database to the development server, change it, 
then copy it back to the staging server.

Each scenario is explained below.
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Moving .aspx Templates from Development to Staging Server

In this scenario, the development server is used to create, modify, 
and test .aspx templates. You set it up as the Send server, and the 
staging server as the Receive server.

When the development work is done, use Site Replication to move 
only new/updated template files from development to staging. 
Then, use a Quick Deploy to move the templates and database 
from staging to production.

If you want to use Quick Deploy, you can only do so between the 
staging and production servers. You can add content to Quick 
Deploy folders, menus, and collections on the staging server.
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Moving the Database from Development to Staging Server

Use this scenario if you are making radical changes to the 
database. Once the changes are finalized, use Site Replication to 
move the files and database from the development to the staging 
server. You cannot add content to the staging server until Site 
Replication pushes the database from the development to it.

Then, use a Quick Deploy to move the templates and database 
from staging to production. Quick Deploy on the staging server can 
also be used to view analytics, forum entries, etc. from the 
production server.

Testing Site Replication Software
On the main Site Replication Screen, a Test Configuration option 
lets you verify that your Site Replication software is working 
properly. You can also use this screen to diagnose problems.
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When you click Test Configuration, the following screen appears.
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This screen lets you verify that Site Replication is configured 
properly. If all tests pass on your sending, receiving, and remote 
machines, Site Replication should function properly.

Tests are grouped by tabs into the following areas.
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List of Tests Per Server

Group These tests verify For more information, see

System Privileges Users have been assigned privileges to 
write files, restart services, etc. These 
activities occur during Site Replication.

• ”Prerequisites” on page 11

• ”If you are not using a trusted con-
nection, the login user defined in the 
Ektron CMS400.NET web.config file 
needs sysadmin privileges. The 
login user is defined in the user tag 
within the web.config’s <connection-
string> element.” on page 25

Local DB If Ektron CMS400.NET  runs on the 
same machine as the Ektron 
CMS400.NET  database server, you can 
back up and restore the Ektron 
CMS400.NET  database.

”Viewing and Restoring a Backup of the 
Production Server” on page 49

Remote DB If you installed a database on a separate 
server, you can back up and restore it.

File Transfer The transfer of files and databases 
between sending and receiving servers.

”What Information is Synchronized” on 
page 8

Notifications Notification email can be sent. ”If you will use email to communicate the 
completion of the replication, SMTP must 
be running on the sending (staging) 
server’s IIS.” on page 29

Tab/Function Use on 
sending 
server

Use on 
receiving 
server

Use on 
remote 
database 
server

System Privileges

Verify CMS and DMS update directories 
are unique
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Identity on current server:

Verify MS SQLDMO is installed

Identity on destination server

Check Staging/Production Flags

Test start/stop indexing service on 
current server

Test writing to a file in receive directory

Test writing to SiteReplication.Backups 
directory

Test writing to SiteReplication.Temp 
directory

Local DB

Test backup CMS DB using Send 
settings:

Test restore DB using Receive settings:

Remote DB

Test backing up DB using 
SiteReplication.Temp:

Test restoring DB using 
SiteReplication.Temp

File Transfer

Tab/Function Use on 
sending 
server

Use on 
receiving 
server

Use on 
remote 
database 
server
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The Scheduler Windows Service
The Site Replication feature installs a Windows service that can 
launch replication at a predetermined date and time. If you want to 
use this option, establish the schedule at the Schedule on field on 
the Sending screen’s Configuration tab (see ”Schedule On” on 
page 40).

The service is named Ektron Replication Scheduler. It starts 
automatically when a Site Replication sending server is installed 
and whenever Windows restarts.

Running the Scheduler Service from a Remote Server

IMPORTANT! Using a localhost web service URL is strongly recommended!

The Site Replication sending server (the one on which you want to 
schedule Site Replication) has an EktronReplScheduler.exe.config 
file, located in C:\Program 
Files\Ektron\SiteReplication\EktronReplScheduler. By default, the file 
includes this line:

    <add key="ReplWS" value="http://localhost/CMS400Replication/Replication.asmx"/>

Check SQL Server Compatibility

Check Site Replication Compatibility

Notifications

Sent Email to:

Tab/Function Use on 
sending 
server

Use on 
receiving 
server

Use on 
remote 
database 
server
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As you can see, the URL points to the Web Services file on the 
sending sender (that is, localhost). 

If you want to reference the web service URL using a non-localhost 
address, change the path to that file in the line above. Then, 
identify the user name and password required to access Site 
Replication on the sending server. To do that, add the following 
lines to the <appsettings> element of the 
EktronReplScheduler.exe.config file.

<add key="WSUsername" value="EKTRON1\siterepuser"/>

<add key="WSPassword" value="SUJL&!"/>

Replace the red text with the domain\user name and password 
required to access the remote server.

NOTE To encrypt the password, use Ektron CMS400.NET’s Password Encrypt utility, 
You can access this from the Windows Start button > All Programs > Ektron > 
CMS400 v70 > Utilities > Encrypt Email Password.

These additions let the Ektron Replication Scheduler Windows 
service communicate with a remote server's Web services file.

Troubleshooting the Scheduler Windows Service
If the service stops or is not working, here are a few things to 
check.

1. Open the Windows folder to which you installed Site 
Replication. By default, this is C:\Program 
Files\Ektron\SiteReplication.

2. Open the EktronReplScheduler folder.
3. Open EktronReplScheduler.exe.config.
4. Within the <Appsettings> tag, look at the value property for the 

ek_ReplWS tag. Make sure the URL points to the sending 
machine's replication Web service URL.
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Using the Scheduler Windows Service with Multiple Sites
If your Ektron CMS400.NET supports multiple Web site, and all sites 
use replication, follow these steps.

1. Use the directions in ”Troubleshooting the Scheduler Windows 
Service” on page 70 to open the 
EktronReplScheduler.exe.config file.

2. Within the <Appsettings> tag, look at the value property. It 
contains the path to the Web services file for the site you 
selected during installation.

3. Insert the path to Web services file for each additional site after 
the path. Separate each path by a comma (,).

Uninstalling the Scheduler Windows Service

Uninstalling the Scheduler Windows Service
If you want to uninstall the Scheduler Windows Service, follow 
these steps.

1. Open the Windows folder to which you installed Site 
Replication. By default, this is C:\Program 
Files\Ektron\SiteReplication.

2. Click the Ektron Repl Scheduler.msi file.
3. A welcome screen appears. Click Next.
4. Click Remove.
5. Click Remove again.
6. The Scheduler Windows Service is uninstalled.

Troubleshooting Problems with Site Replication
Use the following table to troubleshoot error messages that may 
appear while you are using the Site Replication feature. Note that 
message text varies depending on your server name, date, 
database name, etc.
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Error Solution

The request failed with HTTP status 401: 
Unauthorized

You typed an incorrect username or password. 
Typically occurs when Site Replication begins.

Server was unable to process request. ---> Can't 
restore DB. CMS400Min~~7-14-
2006_9~15~53_PM already exists on DB server!

This error appears when your configuration consists of 
two or more production servers that share a database 
and the Send DB When field is set to Always. In this 
case, Site Replication tries to copy to the same 
database on the same machine.
To resolve this error:

1. Go to the sending server.

2. Access the Site Replication software.

3. Click the Configuration tab.

4. Verify that Send DB When is set to 1st 
Destination Only.

Server was unable to process request. ---> Access 
to the path 'C:\Documents and Settings\All 
Users\Application 
Data\sitereplCMS400Replication.config' is denied.

Anonymous Access is enabled for your Ektron 
CMS400.NET  Site Replication directory.
To fix it for the staging and production servers, open IIS 
and disable Anonymous Access on your Site 
Replication directory.
To do that, follow these steps.

1. Open IIS.

2. Navigate to the CMS400Replication directory.

3. Open Properties.

4. On the Directory Security tab, under 
Anonymous Access and Authentication 
Control, click the Edit button.

5. Ensure that Anonymous Access is unchecked.

(The error below appears in the Identity on 
Destination Server test diagnostic.)
Failed! This web application should not allow 
Anonymous access!

See above
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Server was unable to process request. ---> Access 
to the path '\\ZEUS\SiteReplication.Temp\7-14-
2006_9~34~30_PMRecvStageDB.tmp.uncompres
sed' is denied.

Your production server is using a remote database, 
and the specified user does not have permission to 
update it. To resolve the error, follow these steps.

1. Go to SiteReplication.Temp directory. 

2. Right click and choose Properties. 

3. Click the Sharing Tab. 

4. Click the Permissions button. 

5. Add a user that exists on the production and 
database server. (That is, a user in the domain 
these servers share).

6. Give the user Read and Change permissions.

(The error below appears in the Test writing to 
SiteReplication.Temp directory in the test 
diagnostics.)
Failed!
Error: Access to the path 
'\\ZEUS\SiteReplication.Temp\tmp.ekreplprobe' is 
denied

See above

WARNING: Could not copy content_hits_tbl: 
Timeout expired. The timeout period elapsed prior 
to completion of the operation or the server is not 
responding.

Note: The default value, 30 seconds, causes the 
server to time out if your tables are large and the 
MSSQL drives aren't fast enough.

Add the following to your Site Replication production 
server’s web.config file. (Note: This is not the Ektron 
CMS400.NET  web.config file.) 
<add key="ek_SQLCmdTimeout" value="600"/>

The timeout value is in seconds. Increase the value as 
needed to accommodate the copying of your 
content_hits table.

Error Solution
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Server was unable to process request. ---> Could 
not restore database 
'\\ZEUS\SiteReplication.Temp\7-14-
2006_11~21~00_PMRecvStageDB.tmp.uncompre
ssed' on receiver. Error was: [Microsoft][ODBC 
SQL Server Driver][SQL Server]Device activation 
error. The physical file name 'C:\Program 
Files\Microsoft SQL 
Server\MSSQL\Data33\CMS400Min~~7-14-
2006_11~21~00_PM.mdf' may be incorrect. 
[Microsoft][ODBC SQL Server Driver][SQL 
Server]File 'CMS400Min' cannot be restored to 
'C:\Program Files\Microsoft SQL 
Server\MSSQL\Data33\CMS400Min~~7-14-
2006_11~21~00_PM.mdf'. Use WITH MOVE to 
identify a valid location for the file. 
[Microsoft][ODBC SQL Server Driver][SQL 
Server]Device activation error. The physical file 
name 'C:\Program Files\Microsoft SQL 
Server\MSSQL\Data33\CMS400Min~~7-14-
2006_11~21~00_PM_log.ldf' may be incorrect. 
[Microsoft][ODBC SQL Server Driver][SQL 
Server]File 'CMS400Min_log' cannot be restored 
to 'C:\Program Files\Microsoft SQL 
Server\MSSQL\Data33\CMS400Min~~7-14-
2006_11~21~00_PM_log.ldf'. Use WITH MOVE to 
identify a valid location for the file. 
[Microsoft][ODBC SQL Server Driver][SQL 
Server]RESTORE DATABASE is terminating 
abnormally.

The path to the MSSQL Data Directory is incorrect. To 
resolve it, follow these steps.

1. Sign on to the production server.

2. Access the Site Replication software.

3. Open the Configuration Receive screen.

4. On the Configuration tab, enter the correct path 
to the MSSQL Data Directory.

If you are using a remote database, enter the path to 
database server’s MSSQL Data Directory.

Server was unable to process request. ---> Invalid 
Site Replication Sender Connection IP Address!

On the production server‘s Configure Receive screen > 
Security tab, you entered Valid Sender IP address. 
Then, you tried to run Site Replication from a different 
server.
To resolve the error, run Site Replication from server 
specified at Valid Sender IP address.

Server was unable to process request. ---> Invalid 
Site Replication Sender Username or Password!

On the production server‘s Configure Receive screen > 
Security tab, you entered a Valid Username. Then, 
you signed in as a different user and tried to run Site 
Replication.
To resolve the error, sign in as the specified user then 
run Site Replication.

Error Solution
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Server was unable to process request. ---> 
[Microsoft][ODBC SQL Server Driver][SQL 
Server]Cannot open user default database. Login 
failed.

The Site Replication user lacks permission to back up 
and add a new database. To resolve the error, make 
sure the user has SysAdmin permissions for the SQL 
server database.
This user is specified in the <connectionstrings> 
element of the Ektron CMS400.NET  web.config file.
If you do not want to enter the user information into the 
Ektron CMS400.NET  web.config file, enter it into the 
C:\Documents and Settings\All 
Users\Application 
Data\sitereplCMS400Replication.config file. 
Settings in that file override those in the web.config file.
Within sitereplCMS400Replication.config, use 
these fields.

• Send\DBUser – username for accessing the 
sending server’s database

• Send\DBPassword – password for accessing the 
sending server’s database. Be sure to encrypt it 
using Ektron CMS400.NET ’s EncryptEmailPass-
word.exe (located in C:\Program 
Files\Ektron\CMS400vreleasenumber\Utiliti
es)

• Receive\DBUser – username for accessing the 
receiving server’s database

• Receive\DBPassword – password for accessing 
the receiving server’s database. Be sure to 
encrypt it as described above

Failed!
The server rejected one or more recipient 
addresses. The server response was: 550 5.7.1 
Unable to relay for test@ektron.com.

This is an email notification error. To fix it, follow these 
steps.

1. Open IIS.

2. Right click Default SMTP Virtual Server.
3. Choose Properties.

4. Click the Access tab.

5. Click the Relay button.

6. Under Select which computer may relay 
through this virtual server, change the setting 
from Only the list below to All except the list 
below.

7. Make sure the Allow all computers which 
successfully authenticate to relay box is 
checked.

Error Solution
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Uninstalling Site Replication
There is no option to automatically uninstall Site Replication, 
because it can be installed many times on a server. So, to uninstall 
Site Replication, you have to delete everything manually.

To uninstall Site Replication, follow these steps for both the staging 
and production server.

1. Open the C:\Program Files\Ektron\SiteReplication folder.
2. Click the Ektron Repl Scheduler.msi file.
3. Choose the remove option. This removes the Ektron replication 

service.
4. Delete the C:\Program Files\Ektron\SiteReplication folder. 
5. Open C:\Documents and Settings\All Users\Application Data.
6. Delete the sitereplCMS400Replication.config file. 

Status: Last replication failed! Client found 
response content type of 'text/html; -8', but 
expected 'text/xml'. The request failed with the 
error message: -- 
Server Error in '/' Application. 
________________________________________
Runtime Error 
.
.

Occurs at the beginning of a Site Replication. Indicates 
that the Site Replication directory is not set as an 
application.
To make the Site Replication directory an application, 
follow these steps.

1. Go to IIS.

2. Select the CMS400replication folder.

3. Select Properties. 

4. On the Directory tab, under Application Settings 
> Application Name, make sure 
CMS400Replication appears. If it does not, click 
the Create button and enter it.

Do this for both the staging and production site 
replication folders 

While running Test backing up DB using 
SiteReplication.Temp, you get the error below.
Failed using DB User (Trusted Connection)!

Error: [SQL-DMO]Database name required.

Possible fixes

• Check the connection string in the web.config file. 
Delete any blank spaces at the end of the connec-
tion string.

• Make sure the connection string says user (not 
uid) to specify the SQL user.

Error Solution
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7. Delete the CMS400Replication folder in your web root. For 
example, C:\Inetpub\wwwroot\CMS400Replication.

8. On the production machine only, delete the 
C:\SiteReplication.Backups directory. 

9. If you see the C:\SiteReplication.Temp folder, delete it.
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Quick Deploy

Quick Deploy is a simpler form of Site Replication that quickly 
moves updated content and other Ektron CMS400.NET items from 
a staging to production server. It is designed to bypass the normal 
process of QA testing a staging site, then pushing changes to a 
production server via Site Replication.

Quick Deploy also moves data recently collected from site visitors 
on the production server back to the staging server, such as new 
membership users, Content Analytics, and Poll/Survey results. The 
feature is explained through the following topics.

• ”When Not to Use Quick Deploy” on page 78

• ”Information Copied During Quick Deploy” on page 79

• ”Quick Deploy Prerequisites” on page 80

• ”Using Quick Deploy” on page 83

• ”Automatic Movement of CMS Content Using Quick Deploy” on 
page 83

• ”Manual Movement of CMS Content Using Quick Deploy” on 
page 84

• ”Manual Movement of Menus and Collections Using Quick 
Deploy” on page 84

• ”Moving non-Content Files with Quick Deploy” on page 88

• ”Quick Deploy Troubleshooting” on page 90

When Not to Use Quick Deploy
You cannot use Quick Deploy to move regular folders from staging 
to production server. (However, Quick Deploy does copy 
community and Quick Deploy-enabled folders from staging to 
production.) In this case, use Site Replication.
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Also, Quick Deploy is meant to move specific folders. It is not a 
substitute for Site Replication, which copies all folders from staging 
to production.

Information Copied During Quick Deploy

From Staging to Production Server
A Quick Deploy copies the following information from the staging to 
production server.

• Content that is published (whether new or updated) or deleted 
(only folders, Blogs, and Discussion Forums whose Quick 
Deploy property is checked; this includes Community folders)

• Content and folder properties, metadata, and taxonomy

WARNING! New metadata definitions are not moved to the production server by Quick 
Deploy. After you create any new metadata definitions, immediately use Site 
Replication to move them from staging to production. If you do not, your next 
Quick Deploy may generate errors due to metadata definitions that do not exist on 
the production server.

• New or updated files in the uploadedfiles, uploadedimages, 
assets and assetlibrary directories

• CMS and membership users and user groups

• Forum configuration information (replace word table, restricted 
IP addresses, user rank)

• Workflow and permission for folders whose Quick Deploy 
property is checked

• If an administrator initiates the Quick Deploy using the Quick 
Deploy screen

- aspx templates (See ”Moving non-Content Files with Quick 
Deploy” on page 88)

- manually selected files, as described in ”Moving non-
Content Files with Quick Deploy” on page 88

NOTE Collections and Menus have their own Quick Deploy procedure. See ”Manual 
Movement of Menus and Collections Using Quick Deploy” on page 84.
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From Production to Staging Server
Quick Deploy copies following information from the production to 
the staging server. If the information exists on the staging server, it 
is overwritten by production server information.

• Content that is published (whether new or updated) or deleted 
(only folders, Blogs, and Discussion Forums whose Quick 
Deploy property is checked; this includes Community folders)

• New Blog and Discussion Forum comments entered through 
the Web site

• New form submissions and submission tasks. (When forms are 
submitted, new tasks direct users to handle the forms, and 
notification email is sent to the users.)

• Workflow and permission for folders whose Quick Deploy 
property is checked

• Poll/survey results

• Site Analytic information

• Content rating data

• Search phrases

• CMS and membership users and user groups

• Assets

IMPORTANT! If the same file is edited on staging and production servers, the file with the latest 
edit date/time overwrites. In other words, Quick Deploy compares the edit date/
time of any file being imported, and only overwrites an existing file if the new file’s 
edit date/time is later.

Quick Deploy Prerequisites
• Your license key supports Quick Deploy.

NOTE Ektron CMS400.NET’s Site Replication software is an extra cost option. 
Please contact your Ektron Sales representative for details on purchasing it.

• Identify the staging server. To do this, edit the Settings > 
Configuration > Setup screen and check the This is a 
staging server checkbox (see illustration below).

http://www.ektron.com/corporate.aspx?id=1004
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• Both servers have the same version of Ektron CMS400.NET 
(minimum build 6.0.2)

• On both servers, enable Quick Deploy in the web.config. To do 
this, open siteroot/web.config. Then, change the value of the 
<add key="ek_EnableReplication" element to true.

• On both servers, change the password that enables the 
servers to recognize each other. If you do not change the 
password, anyone can send Quick Deploy commands between 
any staging server and any production server on the internet to 
change content.
To do this, follow these steps.
1.Go to the staging server and open siteroot/web.config.
2.Uncomment the ek_ReplPassword element.

<!--add key="ek_ReplPassword" value="MyPassword"/-->

3.Change the value of the ek_ReplPassword element to a unique 
string.
4.Follow the same steps on the production server. The 
passwords on both servers must match.

• In the staging server's web.config, specify the Quick Deploy 
Web service URL. To do this, open siteroot/web.config and find 
the line that specifies the URL.

<add key="ek_ReplicationWS" value="http://localhost/site root folder/WorkArea/WebServices/
ReplicationService.asmx"/>

Within that line, replace localhost with the production server. 
For example:

<add key="ek_ReplicationWS" value="http://555.555.555.55/site root folder/WorkArea/
WebServices/ReplicationService.asmx"/>

• Within Ektron CMS400.NET, check the Quick Deploy property 
for folders, blogs, discussion boards, menus, and collections 
that contain content to be replicated dynamically.
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NOTE You can only set folder properties after all above settings have been made.

To do this, access the folder and click View > Folder 
Properties. Near the bottom of the screen is Quick Deploy 
followed by Yes or No.

To change the Quick Deploy setting, click the Edit button ( ) 
then change the value of the Replicate Folder Contents 
check box (illustrated below).

NOTE Only changes made while the Quick Deploy checkbox is checked are copied to 
the production server. Once you uncheck a folder's Quick Deploy checkbox, 
Quick Deploy ignores changes made to content in a folder, menu, collection, blog, 
or discussion board.

Unlike other folder properties, this value is not inherited in most 
cases -- you must check each folder to be replicated. See Also: 
”Quick Deploy Settings and Community Folders” on page 82.

Quick Deploy Settings and Community Folders

Quick Deploy treats regular folders, Discussion Boards, and Blogs 
equally. Each has a Quick Deploy: Replicate Folder Contents 
checkbox.

However, on Community Folders, Quick Deploy is automatically 
enabled, and there is no checkbox. If you create a Blog or 
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Discussion Board inside a Community Folder, Quick Deploy is 
automatically enabled. Again, there is no checkbox.

NOTE Forums do not display a Quick Deploy checkbox. Instead, the setting is controlled 
by the Forum’s Discussion Board.

Enabling Multiple Production Destinations
If you want Quick Deploy to update several load-balanced 
production servers, identify each one in the staging server’s 
web.config file at the ek_ReplicationWS element. Separate each URL 
with a comma (,). 

The Ektron CMS400.NET database is only synchronized to the first 
server in the list, because all production servers should share the 
same database. Additional servers receive only static file updates, 
that is, files in the uploadedfiles, uploadedimages, assets, and 
assetlibrary directories.

Using Quick Deploy
• ”Automatic Movement of CMS Content Using Quick Deploy” on 

page 83

• ”Manual Movement of CMS Content Using Quick Deploy” on 
page 84

• ”Manual Movement of Menus and Collections Using Quick 
Deploy” on page 84

• ”Moving non-Content Files with Quick Deploy” on page 88

Automatic Movement of CMS Content Using Quick Deploy
Whenever any of these events occurs on the staging server, a 
Quick Deploy is initiated.

• content in any folder for which Quick Deploy has been 
activated is updated (not necessarily published)

• a folder for which Quick Deploy is enabled is created or its 
properties, permissions, or approval chain is updated

• a CMS or membership user or user group is updated
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NOTE Changes made on the production server never initiate a Quick Deploy. This is 
because the staging server is usually behind a firewall.

When one of these events occurs, the Ektron Windows Service 
moves all information ready to be moved between the two servers. 
(See Also: The Ektron CMS400.NET Administrator Manual > 
“Managing Your CMS400 System” > “ Ektron Windows Service.”) 
For a complete list of that information see, ”Information Copied 
During Quick Deploy” on page 79.

Manual Movement of CMS Content Using Quick Deploy
An administrator can initiate a manual Quick Deploy at any time 
using the Quick Deploy screen. To do so, follow these steps.

1. Complete all prerequisites listed in ”Quick Deploy 
Prerequisites” on page 80.

2. Click Settings > Configuration > Quick Deploy.

3. Click the Replicate button ( ). 
4. Starting Replication... appears.
5. Once the connection is established, the screen displays the 

status of the replication. For example:
CMS400.net Replication Started with: http://192.168.0.nnn/site root folder/WorkArea/
WebServices/ReplicationService.asmx at 5/4/2006 11:31:41 AM

6. When Quick Deploy completes, the screen lists the moved files 
and completion date and time.

Manual Movement of Menus and Collections Using Quick 
Deploy

When you create a menu or collection, you can check the 
Quickdeploy This Menu/Collection checkbox. (The checkbox 
can be changed at any time using the Edit Menu/Collection 
screen.) 

If the checkbox is checked, you can move the menu/collection to 
the production server at any time by clicking the Replicate button 
on the View Menu/Collection screen (illustrated below).

NOTE If you are using the approval feature with a collection, the replicate button only 
appears if the collection is approved. See the Ektron CMS400.NET Administrator 
Manual section “Web Site Navigation Aids” > “Collections” > “Setting up Approval 
for Collections.”
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When you click the Replicate button, the following items move from 
staging to production server.

• the selected collection or menu (and its submenus)

• new or updated files in the uploadedfiles, uploadedimages, 
assets and assetlibrary directories

• CMS and membership users and user groups

• forum configuration information (replace word table, restricted 
IP addresses, user rank)

• workflow and permission for folders whose Quick Deploy 
property is checked

In addition, files listed in ”From Production to Staging Server” on 
page 80 are moved from the production to the staging server.

To quick deploy a menu or collection, follow these steps.

1. Complete all prerequisites listed in ”Quick Deploy 
Prerequisites” on page 80.

2. From the staging server’s workarea, go to Modules > Menus. 
or Modules > Collections.

3. Click the menu/collection that you want to deploy to the 
production server. 

NOTE You can only do this with a menu/collection for which Quick Deploy is enabled.

4. Click the Replicate button ( ). 
5. The Quick Deploy screen appears.

6. Click the Replicate button ( ). 
7. Starting Replication... appears.
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8. Once the connection is established, the screen displays the 
status of the replication. For example:

CMS400.net Replication Started with: http://192.168.0.nnn/site root folder/WorkArea/
WebServices/ReplicationService.asmx at 5/4/2006 11:31:41 AM

9. When Quick Deploy completes, the screen lists the moved files 
and completion date and time.

Linking to Library or Content Items

If a Quick Deployed content item, menu, or collection includes a 
link to a library or content item that only resides on the staging 
server, the link appears broken when viewed on production. To fix 
the problem, use Site Replication to push the linked item to 
production.

To help alert you to such problems, Ektron CMS400.NET indicates 
when it is safe to link to content within that folder by displaying 
QuickDeploy next to the folder name.

Quick Deploy Indicator on the Edit Content Screen
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Quick Deploy Indicator on the Add Menu Item Screen

Quick Deploy Indicator on the Add Collection Item Screen
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Moving non-Content Files with Quick Deploy
You can use Quick Deploy to move non-content files from staging 
to production whenever you want. In addition to files listed in 
”Information Copied During Quick Deploy” on page 79, you can 
move other CMS files, such as .aspx templates. The files must 
reside in the Ektron CMS400.NET root directory or a subdirectory.

NOTE You cannot select files within the web.config and the bin directories.

To move non-content files between the servers, follow these steps.

1. Complete all prerequisites listed in ”Quick Deploy 
Prerequisites” on page 80.

2. Click Settings > Configuration > Quick Deploy.
3. Click the Select CMS Files tab.
4. Check each file to move to the production server.

5. Click the Replicate button ( ).
6. Starting Replication... appears.
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7. Once the connection is established, the screen displays the 
status of the replication. For example:

CMS400.net Replication Started with: http://192.168.0.nnn/site root folder/WorkArea/
WebServices/ReplicationService.asmx at 5/4/2006 11:31:41 AM

8. When Quick Deploy completes, the screen lists the moved files 
and completion date and time.

TECHNICAL NOTE Replication log information is also captured in the Windows Event log. If you set 
web.config's ek_LogLevel to 1, every database row that was changed is logged. 
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Quick Deploy Troubleshooting

Symptom Cause Resolution

CMS400.net 
Replication Error:
Access to the path 
'C:\Inetpub\mudslide1\
site root folder\test.txt' 
is denied

User dragged a file into the site root folder 
then tried to Quick Deploy it. The folder lacks 
adequate permissions.

1. Assign the site root folder 
write and modify permis-
sions for the ASPNET and 
IIS_WPG users. See illus-
tration below. 

2. Assign the same 
permissions to the file 
causing the error.
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